


About spreadsheets

You can use a spreadsheet to enter and calculate data. A spreadsheet
consists of columns and rows of cells. You can enter data directly into the
cells of the spreadsheet and perform calculations that are based on the
data by using formulas. When you create an interactive spreadsheet by
using one of the Microsoft Office 2003 design programs and put that
spreadsheet on a Web page, you give Web users the opportunity to
interact with the data and perform calculations directly in the browser.
Users can make changes to the data and see the results of calculations
automatically.

The following example is a spreadsheet on a Web page designed to be
used as a mortgage calculator. When the user changes the values in the
bordered input cells in the browser, the spreadsheet calculates the
mortgage payment.
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» Browser and license requirements

» Design programs you can use to create or modify spreadsheets
» Creating the spreadsheet and customizing it

» Testing and publishing

» About the Spreadsheet Web Part
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About XML lists

When a user or the designer of a Spreadsheet component queries and
imports data from a data source using a data retrieval service or a Data
Retrieval Service Connections file (.uxdc), the data is displayed in a table
structure that is called an XML list. An XML list behaves much like a
datasheet in a database program: each row in the list is treated as a
single record when adding, deleting, filtering, and sorting items in the list.
An XML list is associated with a query that can be refreshed to display
current information from the data source. You can also edit this query to
provide different query parameter values, select different fields, filter data,
and sort data so you can efficiently retrieve just the subset of data you
want.
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An XML list has the following visual features that distinguish it from other
ranges in a spreadsheet.

A frame clearly outlines the data in the XML list. Data inside the frame is
returned from the data source; data outside the frame is not part of the
data returned from the data source.

The XML list can display column headings that are not part of the data
retrieved from the data source, so your headings never get sorted with
the data or excluded when the data is filtered.

The XML list displays a new row at the bottom of the list called the insert
row to make adding a new record simple: just click in the insert row and

type.

If the designer has not locked the entire XML list and disabled other
features of the XML list, working with data in an XML list behaves as
described in the following sections.



» Adding records

» Pasting records

» Deleting records

» Sorting records

» Filtering records

» Inserting and deleting columns
» Calculated columns

» Working with the associated query






Browser support for spreadsheets

To work with interactive spreadsheets, users must have Microsoft Internet
Explorer 5.01 with Service Pack 2 (SP2) or later, the Microsoft Office
Web Components installed, and an appropriate Office 2003 license.
Users who do not have an Office 2003 license can install the components
and view them on a Web page, but cannot interact with them. Learn more
about installation and licensing of components.

Following are the levels of browser support available when users have
the Office Web Components installed and an Office 2003 license.

» Microsoft Internet Explorer 5.01 with Service Pack 2 or later
» Other browsers

Note The Spreadsheet Web Part has the same license requirements as
the spreadsheet component. For more information about the
Spreadsheet Web Part, see the "About the Spreadsheet Web Part"
section in About spreadsheets.







About using a spreadsheet in the browser

This topic provides information about how users in the Microsoft Internet
Explorer Web browser can interact with a spreadsheet that you create.
Understanding the browser capabilities of spreadsheets should help you
better design them to serve the needs of your users.

» Working in a browser vs. a design program
» What users can do in the browser
» Restricting what users can do in the browser

Note The Spreadsheet Web Part has the same browser capabilities and
license requirements as the spreadsheet component. For more
information about the Spreadsheet Web Part, see "About the
Spreadsheet Web Part" in About spreadsheets.




About Microsoft Office Web Components

Microsoft Office Web Components is a set of ActiveX controls installed
with Microsoft Office 2003. With Office Web Components installed on
your computer, you can interactively use a spreadsheet, a PivotTable list,
and a chart on a Web page in Microsoft Internet Explorer 5.01 with
Service Pack 2 (SP2) or later.

If Office Web Components is not installed on your computer but you have
an Office 2003 site license that permits intranet distribution, you can
configure the components so that users will be prompted to download
Office Web Components from your corporate intranet. This allows users
at your site to use a data access page without having Office 2003
software installed on their computers.

For information about how to configure Office Web Components, see the
Microsoft Office Resource Kit Web Site.
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About installing, licensing, and distributing Office Web
Components

When you design a Web page using Microsoft Office Web Components,
any user with a Microsoft Office 2003 license can interact with the
components in the browser to the level of interactivity you provide. That
IS, a user with an appropriate license can make changes to data in a
spreadsheet, change formatting, drag fields in a chart or PivotTable List,
and so on, as long as you didn't protect these options at design time.
Users with an Office 2003 license can also create, design, and modify
components in a design environment such as Microsoft FrontPage or
Microsoft Access.

Users who do not have Office 2003 licenses can view the components
and the data in them, and can print the view of the components, but they
cannot interact with the components or manipulate them in a design
environment. This means that if you distribute a Web page that uses
components, users who have Office 2003 licenses will have access to all
functionality provided, but users without a license can only view the data
and information you've provided.

» Installing the Office Web Components

» Details on licensing and functionality
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About View-only mode for Office Web Components

If you do not have a Microsoft Office 2003 software license installed on
your computer or accessed via a Microsoft Office 2003 application, you
can view a Microsoft Office Web Component— a Spreadsheet
Component, Chart Component, or PivotTable Component— on a Web
page, but you can't interact with it.

To be able to interact with and use full functionality of the component you
are viewing, you must install Microsoft Office 2003 or have access to an
Office 2003 license. If you are in a corporate or group environment,
check with your network administrator for assistance.

When you are in View-only mode, you can:

View data.

Print.

Select and scroll.

Use hyperlinks.

Resize a component.

Select sheets in the Spreadsheet Component.
Expand or collapse members in a PivotTable list.
Refresh data in a PivotTable list.

Use the About, Help, and Refresh commands. Help topics that deal with
interactivity (such as formatting cells, dragging fields, sorting, filtering,
and so on) do not apply.

All commands except About, Help, and Refresh are unavailable in View-
only mode.



Create a Microsoft Office Spreadsheet Component

The specific steps for creating a spreadsheet depend on the program you
are using to design your Web page. For more information, see Help for
that program. If your design program Help does not provide a procedure
for creating components such as spreadsheets, follow these steps:

1. In your design program, open or create the Web page where
you want the spreadsheet to appear.

2. Using the design program's procedure for adding a component
or ActiveX control to a Web page, select the spreadsheet
component and designate the location and initial size of the
component on the Web page.

3. Enter data and formulas in the spreadsheet, or import the data
to use in the spreadsheet.

4. Use the Commands and Options dialog box and toolbar to
customize your spreadsheet.

5. Using the instructions in your design program, publish the
spreadsheet.






About accessing a data source on a different domain

The spreadsheet attempted to access data on another domain, but failed
due to one of the following reasons:

The site being accessed by the control is not included in the list of trusted
sites.

In Internet Explorer, on the Security Settings dialog box, under
Miscellaneous, Access data sources across domains is either set to
Disable, or set to Prompt and when prompted, you clicked Cancel.

To enable access across domains, do the following:
» Enable prompting

» Add the site to the list of trusted sites






About getting help for spreadsheets

Some of the content in this topic may not be applicable to some
languages.

» Getting help in other design programs

» Getting help with writing scripts and programs that use spreadsheets
» Getting and providing help in the browser

» Getting help for the Spreadsheet Web Part
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Keyboard shortcuts in spreadsheets

For information about the keys to activate and deactivate the Microsoft
Office Spreadsheet Component on the page, see Help in your design
program.

» Keys for moving and scrolling in a spreadsheet
» Keys for moving with SCROLL LOCK on

» Keys for working with sheets

» Keys for entering data on a sheet

» Keys for working in cells

» Keys for formatting data

» Keys for editing data

» Keys for inserting, deleting, and copying a selection
» Keys for moving within a selection

» Keys for selecting cells, columns, or rows

» Keys for working with AutoFilter drop-down lists

» Keys for working with Help






About spreadsheet tools, commands, and options

» Toolbar
» Commands and Options dialog box

» Restricting access to the toolbar and Commands and Options dialog
box



Show or hide the spreadsheet toolbar

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Right-click a cell in the spreadsheet, click Commands and
Options on the shortcut menu, and then click the Workbook

tab.
3. Under Showl/Hide, select or clear the Toolbar check box.



Show or hide the Commands and Options dialog box

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.
2. Do one of the following:
e To show the Commands and Options dialog box, click
Commands and Options & on the toolbar.

e To hide the Commands and Options dialog box, click Close
in the upper right corner of the dialog box.



Add or remove sheets

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

Click Commands and Options |=/ on the toolbar, and then click
the Workbook tab.

Under Worksheets, do one of the following:
To add a sheet, click Insert. Repeat to add multiple sheets.

You can change the name of an inserted sheet by selecting the
name in the Sheet name list, typing a new name in the Sheet
name box, and pressing ENTER.

To remove a sheet, click the name of the sheet in the Sheet
name list, and then click Delete.

The sheet and its data are permanently deleted.



Change the name of a sheet

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

On the toolbar, click Commands and Options ], and then
click the Workbook tab.

Under Worksheets, in the Sheet name list, click the name of
the sheet you want to change.

Type the new name in the Sheet name box.

Press ENTER.



Change the order of sheets

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

On the toolbar, click Commands and Options ], and then
click the Workbook tab.

Under Worksheets, in the Sheet name list, click the name of a
sheet you want to move.

Click Up to move the sheet toward the beginning of

the workbook, or Down to move the sheet toward
the end of the workbook.



Show or hide column headers or row headers

Column headers are the letters in gray cells (or in cells of another color,
depending on your Microsoft Windows display settings) across the top of
the spreadsheet, and row headers are the numbers in gray cells down
the side of the spreadsheet.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Sheet tab.

3. Under Show/Hide, select or clear the Column headers or Row
headers check boxes.



Show or hide gridlines in a spreadsheet

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Sheet tab.

3. Under Showl/Hide, select or clear the Gridlines check box.



Show or hide the sheet selector

The sheet selector consists of the Sheet name tab and the Sheet list, the
second of which appears when you click the arrow on the tab.
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1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Workbook tab.

3. Under Show/Hide, select or clear the Sheet selector check
box.



Save changes

To save your changes, use the command in the design program to save
the Web page or the file containing the spreadsheet. For information
about how to save the Web page or file, see Help in your design
program.

Notes

If you published the spreadsheet from a Microsoft Excel worksheet and
then opened the Web page in another design program, saving the Web
page does not save the changes back to the original Excel worksheet.

If you want to save a copy of the spreadsheet as an Excel worksheet on
your computer, you can export the spreadsheet to Excel by clicking
Export to Microsoft Excel =/ on the toolbar. You can also copy
spreadsheet data to Excel and other programs.

Users cannot save the Web page in the browser, but they can export or
copy it from the browser.



Undo changes

To undo the last change you made in the spreadsheet, click Undo [*/| on
the toolbar. You can undo multiple changes (up to 16) by clicking Undo

more than once.

To undo all changes you have made to the spreadsheet since the last
time you saved the Web page, close the Web page without saving it in
the design program.



Print a spreadsheet

To print a spreadsheet on a Web page, you must print the entire Web
page.

To print a spreadsheet from a design window, see Help in your design
program for specific instructions about printing a Web page.

To print a spreadsheet from the browser, click Print on the Microsoft
Internet Explorer File menu.

Note If the spreadsheet is wider or longer than the printed page, the
areas that don't fit on the page are not printed. For more control over how
the data is printed, including the ability to print a long list and set page
breaks, you can export the spreadsheet to Microsoft Excel by clicking
Export to Microsoft Excel =/ on the toolbar. For information about
printing from Excel, see Excel Help.



Show or hide sheets

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Workbook tab.

3. Under Worksheets, in the Sheet name list, select the name of
the sheet you want to show or hide.

4. Click Hide or Unhide.

Note Unhide is available only for hidden sheets. Sheet names for
hidden sheets are followed by (hidden).



Show or hide scroll bars

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Workbook tab.

3. Under Show/Hide, select or clear the Horizontal scrollbar and
Vertical scrollbar check boxes.



Show only part of a spreadsheet

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Sheet tab.

3. In the Viewable range box, type the range to display.

For example, to display rows 1 through 15, type 1:15. To display
columns A through F, type A:F. To display cells Al through B20,

type A1:B20.

Note This setting cannot be changed in the browser.



Turn automatic sizing on or off for a spreadsheet

When the spreadsheet is set to the size of the viewable range and you
turn automatic sizing on, the spreadsheet expands and shrinks on the
Web page depending on content. It changes size as necessary when you
insert and delete rows and columns, or when you change row heights or
column widths.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Advanced tab.

3. Select or clear the Autofit Spreadsheet check box.

If you want to prevent the spreadsheet from expanding beyond
a specified size, type a value— either in pixels or as a
percentage of the entire Web page— in the Max height box or
the Max width box, or in both boxes. For example, to allow the
spreadsheet to expand up to half the width of the Web page,
type 50% in the Max width box. To limit the width of the
spreadsheet to 300 pixels, type 300 in the Max width box.






About entering text, numbers, dates, and times in a
spreadsheet

Some of the content in this topic may not be applicable to some
languages.

» Entering text
» Entering numbers

» Entering dates and times



Enter text, numbers, dates, and times in a spreadsheet

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Click the cell where you want to enter data.
3. Type the data, and then press ENTER or the TAB key.

Notes

To separate the parts of a date, use a slash or a hyphen; for example,
type 9/5/2002 or 5-Sep-2002.

To enter a time based on the 12-hour clock, type a space and then type
AM or PM after the time; for example, type 9:00 PM. Otherwise, the
spreadsheet enters the time as AM.

Precede formulas with an equal (=) sign.

To enter a hyperlink, type the URL address, beginning with a protocol
such as http:/l or ftp:/l, and then press ENTER.

To enter the same data in several cells, select the cells, type the data,
and then press CTRL+ENTER.



How a spreadsheet handles dates in the year 2000 and
beyond

Because the rules that govern the way any calculation program interprets
dates are complex, you should be as specific as possible about dates
whenever you enter them. This will produce the highest level of accuracy
in your date calculations.

How a spreadsheet interprets ambiguous dates \When interpreting
ambiguous dates, the spreadsheet makes certain assumptions. For
example, when you enter a date that includes only the month and one or
two digits, the spreadsheet assumes that 1 through 31 is the day and that
the year is the current year. For instance, the spreadsheet assumes that
December 01 is December 1 of the current year, not December of the
year 2001. The spreadsheet assumes that December 32 is December 1,
1932.

How a spreadsheet interprets two-digit years By default, when you
enter a two-digit year value, the spreadsheet interprets the year as
follows:

00 through 29 The spreadsheet interprets the two-digit year values 00
through 29 as the years 2000 through 2029. For example, if you type the
date 5/28/19, the spreadsheet assumes the date is May 28, 2019.

30 through 99 The spreadsheet interprets the two-digit year values 30
through 99 as the years 1930 through 1999. For example, if you type the
date 5/28/98, the spreadsheet assumes the date is May 28, 1998.

Use four-digit years To ensure that the spreadsheet interprets year
values the way you intended, type year values as four digits (for example,
2001, rather than 01).

If your users' systems are customized differently from your own, dates
that users enter in the browser might be interpreted differently from dates
you enter in the design program. To ensure that dates are interpreted
correctly in the browser, enter all dates with four digits for the year.

Change how years are interpreted Your system administrator, or the
system administrator for your users, can customize Microsoft Office so
that different rules determine how dates are interpreted. For example,

your administrator could change the earliest two-digit year value that's



interpreted as a date in the twentieth century from 30 to another number.
Also, administrators can change the default date format to display four-
digit years instead of two-digit years.

To find out if your system uses customized date interpretation, see your
system administrator. For information about how to customize date
interpretation, see the Office 2003 Resource Kit.



Change data in a cell

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Click the cell you want to change.

3. Do one of the following:

e To enter a new number or text in the cell, replacing the current
contents of the cell, type the new value.

e To change a portion of the contents of the cell, double-click the
cell and make your changes.

4. To accept your changes to the cell, press ENTER.
Notes
A cell can have only one font and text format.

If you see a message indicating that the range is locked, you must turn
off protection before you can modify the cell.






About moving and copying data

When you copy a cell, you copy the entire cell, including formulas and
their resulting values, and cell formats. Cells that you copy or move
replace any data in the area where you paste the cells.

» Copying and moving affects formulas
» Filtering affects copying and moving
» Copying to other programs

» Copying in the Spreadsheet Component differs from Microsoft Excel






Move and copy data
» Move or copy whole cells

» Move or copy characters within a cell






Insert or delete rows or columns

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Do one of the following:
» Insert rows or columns

» Delete rows or columns






Insert, change, or delete a hyperlink
» Insert a hyperlink

» Change a hyperlink

» Delete a hyperlink






Clear cell contents

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Select the cells that you want to clear.
3. Press DELETE.
» Tip



Keep specific rows or columns visible as you scroll a
spreadsheet

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Select the row below the rows you want to keep visible as you
scroll, or select a column to the right of the columns you want to
keep visible.

If you want to keep both specific rows and specific columns
visible as you scroll, select one cell below and to the right of the
rows and columns you want to keep visible.

3. On the toolbar, click Commands and Options ], and then
click the Sheet tab.

4. Click Freeze Panes

Note This setting cannot be changed in the browser.



Change which cell becomes active when you press ENTER

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Advanced tab.

3. To move the active cell selection or to prevent the active cell
selection from moving after you press ENTER, select or clear
the Move after return check box.

If you want to specify the direction in which the active cell
selection should move after you press ENTER, click the arrow
next to the Move direction box and then click Down, Left,
Right, or Up.

Note The cell selection does not move when the boundaries of the
spreadsheet are reached. For example, when the cell selection is set to
move down and you press ENTER in a cell in the bottom row, the
selection does not move.






About formulas

» What is a formula?

» Calculation

» Constants vs. cell references

» Functions






Examples of commonly used formulas
» Create a sum based on one condition

» Count the occurrences of a value or a condition
» Calculate a running balance

» Join first and last names

» Join a date with text

» Increase a number by a percentage






Create a formula

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

Click the cell in which you want to add a formula.
Type an equal sign (=).

Type the formula.

Press ENTER.
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» Tip



Change a formula

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Double-click the cell that contains the formula you want to
change so that the formula appears in the cell.

If the cell contains a hyperlink, click a cell next to the cell you
want to change, and then use an arrow key to select the cell
with the formula you want to change. Then press F2.

3. Make changes to the formula in the cell.

4. Press ENTER.



View a formula and its result at the same time

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Click the cell that contains the formula you want to view.

3. On the toolbar, click Commands and Options ], and then
click the Formula tab.

4. Review the formula in the Formula in active cell (reference)
box. The result of the formula is displayed in the Cell value box.



Insert a total for a range

You can insert a sum for a range of cells automatically by using
AutoSum.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Click the first blank cell that follows the data you want to sum,
either below the column of data or to the right of the data in a
row, or select a column range to sum.

3. On the toolbar, click AutoSum (=],

A suggested formula is displayed in the cell you selected or in
the cell below the column range you selected.

4. Do one of the following:
e To accept the suggested formula, press ENTER.

e To change the suggested formula, select the range you want to
sum and press ENTER.



Change when a spreadsheet calculates

When a spreadsheet contains many formulas, it might take a long time to
calculate. To speed up your work, you can change the calculation mode
from automatic to manual so that you can decide when to recalculate the
spreadsheet.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the spreadsheet toolbar, click Commands and Options [,
and then click the Workbook tab.

3. Under Calculation, do one of the following:

e To recalculate the spreadsheet whenever a value changes,
select Automatic.

e To recalculate the spreadsheet only when you press F9 or click
Calculate, select Manual.






About using names in formulas
» Overview

» Guidelines



Define names for cells, formulas, or constants

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

On the toolbar, click Commands and Options ], and then
click the Formula tab.

Under Names, type the name you want to use in the Name box.

If you want to define a name that is available to only one sheet
(a local name), precede the name you want to use by the sheet
name followed by an exclamation point. For example, if you
want to name a cell Budget, and make it available only on
Sheet2, type the following in the Name box:

Sheet2!Budget

In the Refers to box, type = (equal sign), followed by the
formula, constant value, or reference to the cell or range of cells
you want to name. For example, to name cells Al through A5 on
Sheetl, type the following:

=Sheetl!$A$1:5A$5
Click Define.



Change or delete a defined name

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

On the toolbar, click Commands and Options ], and then
click the Formula tab.

Under Names, in the All names box, click the name you want to
change or remove.

Do one of the following:

To change the name, type a new name in the Name box and
click Define. Then, click the original name in the All names box
and click Remove.

To change the cell, formula, or constant represented by a name,
change it in the Refers to box, and then click Define.

To delete the name, click Remove.






About cell and range references
» Overview

» Relative and absolute references



About calculation

Calculation is the process that a spreadsheet uses to compute formulas
in its cells and then display the results as values. By default, formulas are
automatically calculated when a change occurs in the cells that the
formulas refer to. However, you can change how a spreadsheet
calculates.

Stored vs. displayed values Values are sometimes displayed and
stored differently. Dates and times, for example, are stored as serial
numbers but are usually displayed and printed in one of several date or
time formats. The spreadsheet uses the stored serial numbers in
calculations, which makes it possible to calculate the number of days
between two dates.

The format that stored values are displayed in sometimes depends on
how you choose to format them. For example, you can format a cell that
contains the number 123456789 to display as 1.23E+08 by using the
Scientific format. Or you can format a cell that contains a date with the
serial number 36699 to display as "6/22/2000" or as "22-Jun-2000".
Changing the display of a value does not change the stored value.

The regional settings in Microsoft Windows Control Panel also determine
how number, currency, date, and time formats are displayed. For
example, these settings determine whether years are displayed with two
digits or four digits. See Windows Help for information about these
formats.






About calculation operators

Operators specify the type of calculation that you want to perform on the
elements of a formula. The Spreadsheet Component includes four types
of calculation operators: arithmetic, comparison, text concatenation, and
reference. Operators calculate in a specific order.

» Types of operators

» Order in which operators calculate






About array formulas and array constants

An array formula can perform multiple calculations and then return either
a single result or multiple results. Array formulas act on two or more sets
of values known as array arguments. Each array argument must have the
same number of rows and columns. You create array formulas in the
same way that you create other formulas, except you press
CTRL+SHIFT+ENTER to enter the formula. When you're editing an array
formula, the formula appears in italic formatting.

Array constants can be used in place of references when you don't want
to enter each constant value in a separate cell on the worksheet.

Some of the built-in functions are array formulas, and must be entered as
arrays to get the correct results.

» Using array formulas

» Using array constants






Create an array formula
» Calculate a single result

» Calculate multiple results






Edit an array formula

If an array formula occupies multiple cells, you must edit the entire range
as though it is a single cell. You cannot change just one element of an
array formula.

1. Select the cell that contains the array formula, or if the array
formula occupies multiple cells, select the range that contains
the array formula.

» How?
2. Press F2.
3. Make changes to the array formula.

4. Press CTRL+SHIFT+ENTER.



Select an array formula range

1. Select a cell within the array.

2. Press CTRL+/ (forward slash).






Move or copy an array formula
1. Select the entire array range.
» How?
2. Click Cut (%] or Copy =2/ on the toolbar.

3. Select the entire destination range; otherwise, the array will be
pasted into a single cell.

4. Click Paste |2/,



About using spreadsheet functions

Functions are predefined formulas that perform calculations by using
specific values, called arguments, in a particular order, or structure. For
example, the SUM function totals values or ranges of cells, and the PMT
function calculates the loan payments based on an interest rate, the
length of the loan, and the principal amount of the loan.

Arguments Arguments can be numbers, text, logical values such as
TRUE or FALSE, error values such as #N/A, cell references, constants,
formulas, or other functions. Each argument you designate must produce
a valid value for that argument.

Structure The structure of a function begins with the function name,
followed by an opening parenthesis, the arguments for the function
separated by commas, and a closing parenthesis. If the function starts a
formula, type an equal sign (=) before the function name.

Arguments
=SUM(C1,E1.G1)

Function name



Nested functions

In certain cases, you might need to use a function as one of the
arguments of another function. For example, the following formula uses a
nested AVERAGE function and compares the result with the value 50.

| Mested fun?ticuns

—IF(AVERAGE(F2:F5)>50,SUM{G2:G5),0)

Valid returns When a nested function is used as an argument, it must
return the same type of value that the argument uses. For example, if the
argument returns a TRUE or FALSE value, the nested function must
return TRUE or FALSE. If it doesn't, the spreadsheet displays a #VALUE!
error value.






Format cells in a spreadsheet

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

Select the cells you want to format.

On the toolbar, click Commands and Options ], and then
click the Format tab.

Do one or more of the following:

» Change text font or size

» Change a number format

» Place borders around cells

» Change the background color of cells

» Align data in a cell



Number formats

Some of the content in this topic may not be applicable to some
languages.

You can change the formats of numbers in a spreadsheet by using the
Commands and Options dialog box, both in the design program and at
run time in the browser. The settings in Microsoft Windows Control Panel
also determine how number, currency, date, and time formats are
displayed. For example, these settings determine whether years are
displayed as two digits or four digits. See Windows Help for information
about these formats.

In Microsoft Visual Basic or a script, you can assign custom number
formats to the data. You can also type custom formats available in the
spreadsheet object model in the Number format box. To find out more,
see how to get help for programming a spreadsheet.

The following number formats are available in the Number format list on
the Format tab of the Commands and Options dialog box.

Format Effects

General Displays a number as a date and optional time. For example,
date 8/31/99 05:54 AM.

The fractional part of the number is the time. If a number has
no fractional part, only a date appears. If a number has only a
fractional part and no integer part, only a time appeatrs.

Long date Displays a date according to the Windows regional setting for
the long date format. For example, Thursday, January 25,

2001.
Medium Displays a date according to the Windows regional setting for
date the month and date separator, and displays two digits for the
year. For example, Jan/25/01.
Short Displays a date according to the Windows regional setting for
date the short date format. For example, 1/25/01.

Long time Displays a time according to the Windows regional setting for
the long time format. For example, 8:45:36 PM.

Medium Displays a time in 12-hour format with an AM or PM



time
Short
time
General

Currency

Euro
currency

Fixed

Standard

Percent

Scientific

Yes/no

designator, omitting the seconds. For example, 8:45 PM.

Displays a time in 24-hour format, omitting the seconds. For
example, 20:45.

Displays a number right-aligned, with no thousands separator,
and preceded by a minus sign if negative. Displays up to 11
digits, or 10 digits with a decimal point, rounding additional
digits to the right of the decimal point. Displays numbers with
more than 11 digits to the left of the decimal point in scientific
format. Displays text left-aligned.

Displays a number according to the Windows regional setting
for currency, with a thousands separator if appropriate and
two decimal places. For example, with the default English
(United States) regional settings, $2,532.75.

Displays a number as euro currency, with a thousands
separator and two decimal places. The euro sign is placed
before or after the number according to the Windows regional
setting for currency. For example, with the default English
(United States) regional setting, €12.35.

Displays a number with two decimal places. For example,
68.30.

Displays a number with a thousands separator and two digits
to the right of the decimal point. The Windows regional setting
for numbers determines what's used for the thousands
separator. For example, with a comma as the thousands
separator, 1,800.00.

Displays a number multiplied by 100, with two decimal places
and a percent sign. For example, the value 0.8914 would be
displayed as 89.14%.

Displays a number in exponential notation. For example,
1.25E+10.

Displays No if the number is O; displays Yes for any other
number.

True/false Displays False if the number is O; displays True for any other

On/off

number.

Displays Off if the number is O; displays On for any other
number.



Merge or unmerge cells

1.

In the design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

Select the cells that you want to merge. Keep in mind that when
you merge cells, only data in the upper-left cell of the selected
range is retained. Data in all other cells that you merge is
deleted.

On the toolbar, click Commands and Options ], and then
click the Format tab.

Under Cell format, click Merge Cells 2/ or Unmerge Cells El






Change the width of a column

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Make sure column headers are displayed.
» How?
3. Select the columns you want to change.

4. Point to the right boundary of the column header of the column
or selection until the pointer changes to +-.

5. Drag the boundary to the width you want, or, to make the
column width fit the contents, double-click the right column
boundary.






Change the height of a row

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Make sure row numbers are displayed.
» How?
3. Select the rows you want to change.

4. Point to the bottom boundary of the row header of the row or
selection until the pointer changes to +.

5. Drag the boundary until the row or selection is the height you
want, or, to make the row height fit the contents, double-click the
bottom row boundary.






Display text or a spreadsheet so that it reads right to left or
left to right

Use right-to-left text direction or display when your spreadsheet will be
viewed in languages that read from right to left.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Do one of the following:
» Display an entire spreadsheet right to left or left to right

» Display text right to left or left to right






Create a chart based on a spreadsheet

If you publish a spreadsheet from Microsoft Excel, you can take
advantage of extensive Excel charting capabilities to create a chart
based on spreadsheet data and publish the chart with the spreadsheet.
This is one of the easiest ways to create a chart based on a spreadsheet.

In other design programs, you can create a spreadsheet and a chart by
using two Microsoft Office Web Components: the Spreadsheet
Component and the Chart Component.

Follow these steps to create a chart for your spreadsheet.

1.

8.

Following the directions in your design program, use the
Spreadsheet Component to create the spreadsheet on a Web
page, and then add the data you want to use in your chatrt.

Following the directions in your design program, use the Chart
Component to create a chart on the same Web page where the
spreadsheet exists.

If the Commands and Options dialog box does not appear,
click the chart.

On the Data Source tab, under Select where the chart data
comes from, click Data from the following Web page item.

Click the spreadsheet item in the list.

Under Set details for the data type, click Ranges.
Do one of the following:

» Specify all the data at one time

» Specify one series of data at a time

Click the Type tab, and then select the type of chart you want.

Note For help with Chart commands and options such as formatting and
modifying the chart, click Help 9] on the General tab of the chart
Commands and Options dialog box.



About finding data

The Find what feature (Commands and Options dialog box, Sheet tab)
can locate text, numbers, dates, and times that have been entered
directly into cells or that are the results of formulas.

Keep the following guidelines in mind when using Find what options:

Match case By default, Find what is not case sensitive. To find only
those cells with values that match the case of your entry, select the
Match case check box.

Entire cell only By default, Find what searches for cells that include the
value you enter in the Find what box. For example, an entry of "John"
finds cells with strings such as "Johnson" or "Little John." To find cells
that contain only the value you entered and nothing else, select the
Entire cell only check box.

Formatted values The Find what feature searches for displayed values,
not formats. For example, suppose a cell is formatted with the Yes/No
number format. If the cell contains a zero (0), the cell displays the word
No, and you can use Find what to locate the phrase "No". You can't use
Find what to find all cells formatted with a particular color or font.

Search direction The Find what feature searches from left to right
across the columns of the first row, and then from left to right across the
columns of the second row, and so on.

Wildcard characters The Find what feature does not allow wildcard
characters such as question mark (?) and asterisk (*).

Hidden data The Find what feature does not find data in hidden cells or
cells hidden by filtering.



Find data

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. To search the entire spreadsheet, click a single cell, or, to
search within a specific range of cells, select the range.

3. On the toolbar, click Commands and Options ], and then
click the Sheet tab.

4. In the Find what box, type the text or value you want to find.
Notes

e By default, Find what searches for cells that include the value
you enter in the Find what box. For example, an entry of "John"
finds cells with strings such as "Johnson" or "Little John." If you
want to find cells that contain only the value you entered and
nothing else, select the Entire cell only check box.

e By default, Find what is not case sensitive. If you want to find
only those cells with values that match the case of your entry,
select the Match case check box.

5. Click Find Next.






Sort data

Data that you want to sort should be set up as a list. A list has similar
items in each column, has labels for the columns across the top row, and
does not include any blank rows or columns.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Do one of the following:
» Sort by a single column

» Sort by more than one column






Apply or remove a filter
» Apply a filter

» Remove a filter






Sum filtered data

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Filter the data to display the rows you want to sum.
» How?
3. Click the cell below the data you want to sum.

4. Click AutoSum (=] on the toolbar, and then press ENTER.

Note The AutoSum button sums only the data in visible rows. To include
all rows in the sum, show all rows and then sum the rows.



About spreadsheets published from Excel

When you publish a spreadsheet from Microsoft Excel, you can open the
Web page and make design changes in Microsoft FrontPage or data
access page Design view in Microsoft Access. You can also open the
Excel worksheet (.xIs file) if you saved it, make changes, and republish
the spreadsheet to the same Web page. If you didn't save the Excel
worksheet, you can export the spreadsheet to Excel, make changes, and
either save a copy of the worksheet or publish the changed spreadsheet.

When you publish a spreadsheet from Excel, most of the Excel features
are retained and work the same way as in Excel. Features in the
following list will work differently or will not be retained when published or
saved as a spreadsheet on a Web page.

Excel

formulas,

functions, and

calculation What happens when published or saved as a Web
features page

Labels in Labels are converted to cell references.
formulas

References to As long as you publish the entire workbook, references

data on other to other worksheets publish correctly. If you publish only

worksheets the referencing worksheet, references to other
worksheets are converted to values.

Subtotals Numbers and calculations appear correctly. Group and
outline features are not retained.

1904 date The displayed dates remain the same, but the serial

system numbers for the dates are converted to the 1900 date
system.

Precision as  Cell value is published.

displayed

R1C1 R1C1 reference style is converted to Al reference style.

reference style

Excel
formatting,



graphics, and
display
features

Rotated or
vertical text

Distributed
alignment

Thai alignment
Indented text

Wrapped text in
cells

Graphics
Pattern fills

Dash dot
borders

Multiple fonts in
a single cell

Conditional
formatting

Cell comments

Data validation
restrictions and
messages

Auditing tracer
arrows

Outlining

What happens when published or saved as a Web
page
Rotated or vertical text is converted to horizontal text.

Not retained.

Not retained.
Not retained.
Not retained.

Not retained.
Not retained.
Dash dot borders are converted to solid borders.

Not retained. The font of the first character in the cell is
used.

Not retained.

Not retained.

All validation types except Custom and List are
retained. Additionally, cell references in validation rules,
custom input messages, and custom error messages
are not supported.

Not retained.

Collapsed rows are published as hidden. Expanded
rows are published normally.

Printing or page Not retained.

setup features

Excel file, sharing, and What happens when published or saved as

import features

a Web page

Shared workbook Not retained.



information

Lotus compatibility R1C1 reference style is converted to Al
reference style.

External data ranges Values are published. The ability to refresh
from the source data is not retained.

Web queries Values are published. The ability to refresh
from the source data is not retained.
Passwords To publish a protected worksheet, you must

use a blank (or no) password.

Excel list and XML What happens when published or saved as a
List features Web page

Lists Not retained.

XML lists The XML list is retained, but if the list has a totals
row, the totals row is not retained.



Export a spreadsheet to an Excel workbook

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the spreadsheet toolbar, click Export to Microsoft Excel
to run or switch to Microsoft Excel and display the data in a
workbook.

Notes

Because Excel supports 256 columns and 65,536 rows, data in columns
IW through ZZZ and rows 65,537 through 262,144 are not exported from
the spreadsheet. You can, however, copy this data to more than one
Excel worksheet.

When you export data from a spreadsheet to Excel, only the values and
formulas are exported. Links that connect to other data on the Web page
or to other Web pages are not retained in Excel.

When you export some spreadsheet number formats, the data in Excel is
displayed with a custom number format. For example, the Yes/no,
True/false, and On/off spreadsheet formats are displayed with custom
number formats in Excel. For information about custom number formats
in Excel, see Excel Help.






Get data from other sources
» Copy and paste data from another program
» Import data from a Web page, text file, or XML file

» Connect to a data source


http://r.office.microsoft.com/r/rlidAWSContentRedir?AssetID=XT010430511033&CTT=11&Origin=HP052740941033




Restrict use of a spreadsheet in the browser

You can prevent users from making changes to sheets by using
protection options that are available only during design time. These
options take effect during run time, and generally do not apply while
you're designing the spreadsheet.

» Protect entire sheet

» Protect only specific cells

» Display only part of a spreadsheet

» Prevent sheets from being inserted, removed, or renamed

» Prevent display of the Commands and Options dialog box

» Prevent or allow monitoring of events by programs and scripts
Notes

You cannot set passwords on spreadsheets.

If you don't want users to make changes to your spreadsheet, consider
publishing a noninteractive HTML version of the spreadsheet. See
Microsoft Excel Help for more information.



Remove protection from a spreadsheet

This procedure can be performed at design time only. Browser users do
not have access to this option.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. On the toolbar, click Commands and Options =], and then
click the Protection tab.

3. Under Sheet, clear the Protect active sheet check box.

4. If you want users to be able to insert, remove, or rename
sheets, or use the Commands and Options dialog box, check
to be sure that the Insert, remove, or rename sheets check
box and the Commands and Options dialog box check box
under Workbook are selected.



About making connections to external data sources more
secure

When you define a connection to an external data source for a
spreadsheet component on a Web page, the authoring environment
stores this information as an unencrypted (plain text) connection string in
the HTML source. As a result, a user opening the page in a browser can
easily view the HTML source for the page and read the connection string,
which may include a user name and password.

To prevent unauthorized access using information from the connection
string, if the data source supports this mode of authentication, use
Windows Authentication (also referred to as a Trusted Connection and
Integrated Security), which uses the current user's Microsoft Windows
account to connect to an external data source. Using Windows
Authentication to connect to an external data source has the following
advantages:

The page designer doesn't have to enter a user name or password to
connect to the data source, so that information cannot be exposed in the
HTML source of the page.

The user of the page doesn't have to enter a user name or password to
connect to the data source when opening the page, so that information
cannot be compromised while it's being sent to the server.

Only a Windows user account that is configured in the security system for
the data source will be allowed to connect to that data source.

Important To use Windows Authentication, the users you want to
connect to an external data source must have user accounts on a
Windows domain. Users that are members of a Windows Workgroup
cannot use Windows Authentication.

As an example, to connect to Microsoft SQL Server using Windows
Authentication, use the following procedure when defining a connection.

Important Before you can use Windows Authentication to connect to a
Microsoft SQL Server database, a server administrator must configure
the server to use this mode of authentication, and must grant your
Windows user account (or a group of which your user account is a



member) login access. Additionally, the server administrator should
provide your account with the minimum level of permissions to the tables
or stored procedures required for your spreadsheet.

1. Inthe design window, make sure the spreadsheet is activated.
For instructions, see Help for your design program.

2. Click Commands and Options on the toolbar, and then click
the Data Source tab.

3. Click Edit, and then double-click New SQL Server Connection.
4. In Server name, specify the name of the server.

5. Under Log on credentials, click Use Windows
Authentication.

6. Click Next, and then follow the directions in remaining screens
of the Data Connection Wizard to specify the data to retrieve.

Note Other data sources that support Windows Authentication may
present different options in the Data Connection Wizard. For example, to
connect to an Oracle database by using Windows Authentication, you
must enter only a forward slash (/) in the User Name box. For more
information, see the documentation for the data source provider you are
using.

If Windows Authentication is not available for the data source you want to
connect to, you must enter a user name and password to connect to the
data source. Because this user name and password might be viewed
when the spreadsheet is on a Web page, do not use this mode of
authentication to connect to sensitive data from a spreadsheet on a Web
page. Even if you are not concerned about unauthorized users viewing
your data, you should connect only with a user account that has limited
permissions on the data source. For example, when connecting to a SQL
Server database using a user name and password, do not use the SA
account or any other account that has elevated permissions, because an
unauthorized user might be able to use this account and password to
access other data on the server.

Note If you use the Data Retrieval Service for Microsoft SQL Server
(or use a Data Retrieval Service Connections (.uxdc) file that is



defined to use that data retrieval service) to connect to an external data
source, and you do not use Windows Authentication, the user name and
password used to connect to the data source are not saved in the Web

page. When you use this method to connect to an external data source,

users of the Web Page that hosts your spreadsheet will be prompted to
enter their logon information.






Troubleshoot spreadsheets

Finding Help information

» | can't find the help information | want



Entering and editing data and formulas

» | can't change cells in the spreadsheet.

» | can't wrap text within cells in a spreadsheet.

» There is no formula bar in my spreadsheet.

» | can't set a password for a spreadsheet.

» | can't change a hyperlink that | published from Microsoft Excel.
» | can't control the size of my spreadsheet.

» | can't control whether scroll bars are displayed or hidden in my
spreadsheet.



Filtering, sorting, and finding data

» Data does not sort correctly in a spreadsheet.

» My spreadsheet list does not show all of my data.

» | have merged cells, and | can't filter my spreadsheet.

» The Find Next command is not finding data in my spreadsheet.

» | published a spreadsheet from Excel, and the AutoFilter drop-down list
IS wrong.



Importing and exporting
» | can't publish a password-protected spreadsheet from Excel.
» My spreadsheet filter is not exporting to Excel correctly.

» | get a message that there are too many rows or columns when | try to
export my spreadsheet to Excel.



Working with the spreadsheet in the browser
» Users cannot interact with my spreadsheet in the browser.

» When | open a Web page that contains a spreadsheet in the browser, |
receive the error "Cannot open URL."

» Clicking the Edit button in my Web browser opens my Web page in the
wrong program.



Error values
» | see error values instead of results for formulas.
Accessing a data source on another domain

» The spreadsheet attempted to access data on another domain, but
failed.






Troubleshoot error values in a spreadsheet

If a formula cannot properly evaluate a result, the spreadsheet displays
an error value. For example, error values can result when a formula
expects a numeric value but finds text, when a cell that is referenced by a
formula has been deleted, or when the cell is not wide enough to display
the result.

Error values might not be caused by the formula itself. For example, if a
formula shows #N/A or #VALUE!, a cell referenced by the formula might
contain the error.

Following are possible causes and solutions for each error value.
b HHHH

» #CIRC!

» #DIV/O!

» #N/A

» #NAME?

» #NULL!

» #FNUM!

» #REF!

» #VALUE!



